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1. Introduction

Have you ever tried to integrate documentation with your program source text, to explain to
other programmers (or even to your future self) what you intend your code to do, or to add
some graphics detailing the data structures? Probably not. Current program editors don’t
allow graphics, and they don’t help you in writing nicely formatted texts. You could use a
word processor instead, if only you knew how to extract the source code for the compiler…

Enter the Literate Programming Workshop™. LPW is a program editing environment
for “literate programming”, the integrated development of program source text and
documentation in mixed documents. The term “literate programming” has been coined by
Donald Knuth, and he also developed the first system to support it, called WEB.
Unfortunately, WEB is a batch system, built on top of Knuth’s TeX document formatting
language. LPW, on the other hand, is a true Macintosh application: fully interactive,
WYSIWYG, and easy to use.

LPW consists of two main components: a word processor for editing documents which
contain both source text and documentation (these documents are called “module
documents” in LPW), and a project management system that keeps track of all the
documents of a software development project and maintains globally useful information
regarding them in “project documents”.

The Literate Programming Workshop is designed to be used in conjunction with the
Macintosh Programmer’s Workshop (MPW), Apple’s programming environment for the
Macintosh. You use LPW as a replacement for the MPW editor, but still use MPW for
executing build scripts and running the compilers, the linker and Rez.

1.1 Main Features of the Editor

To support literate programming, the editor combines features which are usually found
either only in word processors or only in program editors, and adds a new feature called
“excerpts”, which allow to extract a subset of the paragraphs of a module document.

Word processing in the Literate Programming Workshop is purely based on style
sheets. Word processors such as Microsoft Word allow you either to mark up selected
portions of text with “Times 12 point bold”, or to use a style definition for this purpose.
LPW only allows the latter.

The idea behind style sheets is to separate form and contents of your documents: in the
main part of a document, you give the text and the graphics, and state the function for the
document for each text section. In the style sheet, you then specify how text or graphics
with a given function is to be displayed. So, for a program module document, you would
for example have paragraph styles “Procedure Heading”, “Procedure Body”, and “Type
Declaration” for source text paragraphs, but also “Chapter Heading” and “Body Text”
for documentation text.

As a LPW document has style information about each paragraph (and thus information



about the function of each paragraph), we can use this information for defining
“excerpts”. As mentioned above, an excerpt is a subset of all the paragraphs in a
document. This subset is selected according to an excerpt definition, in which you mention
all paragraph styles that a paragraph can have to be part of that subset. For example, to
extract the program source text from a module document, you could define an excerpt
“Source Text”, giving the paragraph styles “Procedure Heading”, “Procedure Body”,
and “Type Declaration”, but not “Chapter Heading” or “Body Text”. You can define an
arbitrary number of excerpts for a document. Useful examples are a “Contents” excerpt,
containing all chapter or section headings, or a “Reference” excerpt, containing procedure
headings, type declarations, and their respective documentation.

An excerpt is a partial view on a document that can be displayed on screen, printed, or
saved to disk using the “Save As” command. The latter makes it possible to prepare
source text files for MPW, but, as we will see later, there is a better way to do this.

In addition to paragraph styles you can have highlight styles, which allow you to
highlight text within a paragraph, for example a definition or a programming language
keyword.

All the definitions of paragraph styles, highlight styles, and excerpts, as well as
descriptions of the page layout and a page header are bundled in a style sheet. Each module
document has its own style sheet, but can use a shared external style sheet instead.

For each paragraph style, highlight style, or excerpt, LPW creates a separate menu
command, and even allows you to assign your own keyboard equivalents to the menu
commands. Therefore LPW styles are easier to deal with than the usual Font, Style, and
Size menus. You can always change a definition; text that already uses a style you change
is immediately reformatted according to the new definition.

1.2 Project Management

Big software development projects usually consist of dozens or hundreds of modules. You
don’t really want to have to keep track of changes made to all those modules and to use the
“Save As” command to extract the source text for each changed module. You also don’t
want to build a new style sheet for each and every module you create.

That’s why LPW has project documents. In project documents, you bundle the
information LPW needs to keep track of all the modules of your software project. You can
also promote a style sheet document to a project style sheet which is then used as a
common style sheet for all the modules in the project.

Once a project document is created, the project management component lets you create
up-to-date source files for MPW for the entire project with a single menu command. After
MPW has done its job, you can get error messages created by the compilers back into
LPW and have them displayed in conjunction with the original source text.
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1.3 The Interactive Index

LPW lets you create and interactively use an index to the contents of all modules in a
project. With simple mouse or menu commands you can access the definition of an
identifier or a documentation term, or of other locations where an identifier or term is used.
You can manually create index entries or you can have LPW automatically create entries for
identifier declarations.

1.4 System Requirements

You can run LPW on any Macintosh computer with at least System Software 6.0 and
700KB of available main memory. As you usually would use LPW in conjunction with
MPW under MultiFinder or System 7.0, your Macintosh system should have at least a
68020 CPU, 4MB main memory and a hard disk. LPW also runs in the Classic
environment on Mac OS X.
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2. Literate Programming Workshop
Documents

2.1 LPW Document Types

PreferencesApplication Style SheetModule Project

When working with LPW, you will encounter five different document types, each
represented by its own icon. All icons are variations on the “book with flow chart” theme.
The first one of course is the application itself. Module documents hold program source
text and documentation for the modules of the program you develop. A project document
holds the information about the modules belonging to your project that is necessary to
exchange information with MPW. Style sheet documents can hold style information shared
between all modules in a project. The preferences file holds some information about your
preferences and is located in the Preferences folder under System 7.0 or later, or in the
System Folder for earlier systems.

2.2 Module and Style Sheet Documents

The idea behind style sheets is to separate contents and form. The main part of a module
document contains text paragraphs, graphics, and information about which styles to use for
those contents. The style sheet used for the module document then has the information how
to display the contents, how to print them, and how to extract excerpts. It therefore contains
definitions for paragraph styles, highlight styles, excerpts, the page layout, and the page
header. The following figure shows the relationships between a module document and its
style sheet.
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The page layout and page header information and the current excerpt are associated with
the entire document. Each paragraph or picture has an associated paragraph style. Each
character also has an associated highlight style – if you have not selected a more
meaningful highlight style, the default “Paragraph Style” is used. This style does not
highlight anything, and might be compared to the “Plain Text” style of other word
processors.

Now, where does a module find its style sheet? It depends.

For displaying the contents of a module document, we always need a style sheet.
Therefore, each module document needs to have a style sheet in its file, just in case you
want to take a copy of it to a different computer. On the other hand, you probably don’t
want to create a new style sheet for each module document you create. Therefore, LPW
uses a dual approach: First, each module document contains its own local style sheet.
Second, you can have separate style sheet documents and use them as project style sheets.
When a module has access to a project style sheet, it will use the project style sheet,
otherwise it will use its own local style sheet. You will learn more about project style sheets
in section 5.3 “Working With a Project Style Sheet”. Until then, it suffices to know that
an open module document uses exactly one style sheet at any time, and all style sheet
commands relate to that style sheet.

2.3 Determining Whether a Document Can Be Modified

In the lower left corner of document windows you will find small icons that tell you
whether the document can be modified.
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Modifiability Icon

You may encounter four different icons:

modifiable

locked

read-only

modifiable-read-only

The most common one is the “modifiable” icon, telling you that there are no restrictions
on modifying the document. From the Finder you may know the “locked” icon, which is
displayed when the document itself or the disk it resides on is locked. LPW will not allow
you to modify a locked document. You may however use the “Save As” command to save
the document to a different file; the icon will then be replaced by the “modifiable” icon,
and you can start working on the document.

The other two icons only show up if you use Projector, a component of MPW that lets
you archive multiple versions of any files belonging to your software project, and helps you
coordinate the cooperation of several programmers working on one project. If you do not
use Projector, you may safely ignore the remainder of this section.

The “read-only” icon is shown if the document was checked out from Projector read-
only. LPW will not let you modify a read-only document. If you really need to modify a
document that you checked out read-only, and you currently do not have access to the
Projector database, you may convert the document to modifiable-read-only status using the
“Allow Modifications” command (this is equivalent to MPW’s “ModifyReadOnly”
command). LPW will then let you make changes to the document. When you check a
modified read-only document back into the Projector database, you may however discover
that someone else has modified the document as well, so you will have to merge the two
versions.
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3. Creating a Style Sheet

3.1 The Style Sheet Window

The style sheet window gives you access to all information contained in a style sheet. There
are several ways to open a style sheet window:

• If the active document is a module document and you want to see the style sheet used
by that module document, choose the “Show Style Sheet” command from the “Edit”
menu.

• If the active document is a project document and you want to see the project style sheet,
again choose the “Show Style Sheet” command from the “Edit” menu.

• If you want to see some style sheet document, open it using the “Open” command.

This is the style sheet window for this manual:

The upper portion of the window contains three lists that show – from left to right – the
currently defined paragraph styles, highlight styles, and excerpts. The row below holds
buttons for creating new definitions, and the bottom row has buttons for changing the page
layout and the page header.

The definitions for paragraph styles, highlight styles, excerpts, page layouts, and page
headers can be shown and modified through dialog boxes, which are explained in detail in
sections 3.3 through 3.7. To get access to one of those dialog boxes, you double-click a list
entry if you wish to modify a style or excerpt definition, click a button in the middle row if
you wish to create a new style or excerpt definition, or click a button in the bottom row if
you wish to modify the page layout or the page header.

You can also use the lists to reorder or delete paragraph styles, highlight styles, and
excerpts. To move an entry to a different location in a list, drag the entry to the new
location. To remove a style or excerpt definition you no longer need, select the entry in its
list, then choose the “Clear” command. The menus will be adjusted automatically.



3.2 The Style Sheet Menu Commands

There are five menu commands that let you by-pass the style sheet window and change
style sheet definitions directly. You would use them primarily while you are working on a
module document and need to quickly change the style sheet used by that module
document. You can also use these menu commands while a style sheet window is active (if
you feel more comfortable using the menus):

• “Page Layout” in the “File” menu lets you modify the page layout

• “Page Header” in the “File” menu lets you modify the page header

• “Define Paragraph Style” in the “Paragraph” menu lets you either define a new
paragraph style or modify an existing one

• “Define Highlight Style” in the “Highlight” menu lets you either define a new
highlight style or modify an existing one

• “Define Excerpt” in the “Excerpt” menu lets you either define a new excerpt or
modify an existing one.

The dialog boxes opened by choosing the “Page Layout” and “Page Header” commands
show the current definition for the item you selected and let you modify it. The dialog
boxes opened by choosing the “Define…” commands initially show default values for a
new entry. To modify an existing entry, choose that entry from the menu.

To confirm the changes you have made, click the “Set” button in the dialog box. The
changes are immediately applied to all open module documents that use the style sheet you
have changed. To discard the changes, click the “Cancel” button.

3.3 Defining a Paragraph Style

Don’t worry, this already is the most complex dialog box you will encounter within LPW.
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Some of the components also appear in some other dialog boxes, so what you learn now
will help you later:

• The name of the paragraph style that you enter in the top left field is used for display
both in the style sheet window and in the menu.

• The keyboard equivalent that you enter to the right of the name can be used later to
choose the paragraph style. Just as you can quit a program by typing �-Q, you can
select a paragraph style by holding down the � key and typing the key you entered
here. LPW won’t let you use keyboard equivalents that are already taken by the
standard LPW menus.

• The buttons Set and Cancel let you confirm or discard the changes you have made.

• The language you select from the list can be a programming language (such as Pascal),
a natural language (such as English), or one of the pseudo languages “Pictures” and
“Math Symbols”. The language you select influences the following features:

– It restricts the selection of fonts shown in the next list – to see the effect, try
switching between “English” and “Math Symbols”.

– It determines the interpretation of the Return character which depends on whether
the current paragraph is written in a programming language or a natural language.
For natural languages, typing the Return key ends the current paragraph and starts a
new one. You can see this if you have entered non-zero margins. For programming
languages, you usually don’t want to have empty space between the lines, so typing
the Return key only starts a new line. A new paragraph is only started when you
type Option-Return. As you may have guessed, typing Option-Return in a natural
language paragraph starts a new line only, not a new paragraph.

– When you paste unformatted text taken from a different application into a module
document, the Return characters in the text are interpreted similarly. When pasting
into a natural language paragraph, each Return character starts a new paragraph.
When pasting into a programming language paragraph, a new paragraph is only
started when two consecutive Return characters are encountered.

– When wrapping a line of programming source text in a paragraph whose style has
the Auto Indent option selected and a repeating tab defined, LPW automatically
indents another two tab stops. For non-programming language text, it indents to the
same level as the previous line.

– For programming languages, word selection may use the programming language’s
definition of a word instead of a language-independent default definition. E.g.,
when you double-click the character sequence “<>” in Pascal text, you select the
entire sequence (which is a Pascal operator) instead of a single character.

– When you type the characters “"”, “'”, or “´” in natural language text, LPW can
automatically replace those with the typographic quotation marks and apostrophes
commonly used in the current language. It takes some guessing, but usually LPW
guesses right. You can enable or disable this feature using the “Preferences”
command in the “” menu.

– When you use an excerpt for extracting source text from a module document, LPW
checks that all paragraph styles in the excerpt use the same programming language.

– When updating the source files for MPW, LPW generates file names using
language-dependent suffixes.
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• Font family, size, and style have the same meaning as in any other word processor.

• The ruler always shows the type area width defined in the page layout. You can use the
following markers to customize the ruler:

left or right indent

first-line indent

repeating flush left tab stop

center tab stop

flush right tab stop

flush left tab stop

The markers for left, right, and first-line indent are always attached to the ruler, you can
only move then horizontally. To set a tab stop, you have to drag a marker out of the
marker box and attach it to the ruler. To remove a tab stop, just drag the marker away
from the ruler.

The repeating tab stop is the one you would usually use for program source text: it
defines a sequence of tab stops at intervals equaling the distance between the marker
you set and the left indent. The other tab stop markers define a single tab stop each.

As there is no meaningful interpretation for tab stops in paragraphs that are aligned
flush right or centered, they are ignored in those paragraphs. If you type a tab key and
there is no tab stop to jump to, a new line is started.

• For the top and bottom margin you specify the minimum space to be maintained
between the current paragraph and the preceding and following ones. LPW determines
the space between two paragraphs by looking at both paragraphs’ styles. The inter-
paragraph space is the maximum of the bottom margin of the first paragraph and the
top margin of the second paragraph. If a paragraph starts on a new page because you
have selected the “New Page” option, the paragraph is set at the offset from the top of
the type area given by the top margin.

• The line spacing you enter is strictly maintained by LPW – if you use a highlight style
that uses larger letters than the paragraph, LPW does not automatically increase the line
spacing.

• You have five options for text alignment or justification – the unlimited-width lines
common in program editors and the four options common in word processors.

left align – right ragged, unlimited width

right align – left ragged

center

justify

left align – right ragged
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• If you select Auto Indent, LPW automatically indents as far as you have indented the
preceding line when you start a new line within a paragraph or when it wraps around to
a new line. When it wraps around in program source text and a repeating tab stop is
defined, LPW adds an increment of two tab stops.

• If you select New Page, each paragraph using this paragraph style starts a new page
when printing.

3.4 Defining a Highlight Style

Compared to the paragraph style dialog box, all components relating to paragraph features
have disappeared. The definition of a highlight style is always relative to the definition of
the paragraph style of the paragraph that the highlighted text belongs to. New dialog
components let you define in which way highlighted text should be distinguished from
surrounding text in the following manner:

• If you select the Set Language and Font option, the highlighted text uses the language
and font selected for the highlight style instead of the ones selected for the paragraph
style.

• If you select the Set Font Size option, the highlighted text uses the font size selected for
the highlight style instead of the one selected for the paragraph style.

• For the Font Style you have three options:

– Don’t modify – use the font style of the base paragraph style.
– Set Style – use the font style selected for the highlight style, no matter what has been

selected for the paragraph style.
– Add Checked Style Items – use the style features selected for the paragraph style

plus those selected for the highlight style.
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3.5 Defining an Excerpt

The upper row of dialog items has the same meaning as the respective items for paragraph
and highlight styles. The only new component is a list of the paragraph styles defined in
your style sheet. From this list, you select the paragraph styles that a paragraph can have to
be part of the excerpt. To select list items, you use the mouse and the standard modifier
keys. To:

• select a single list item, simply click that item.

• select all items between an already selected item and another item, hold down the Shift
key and click that second item.

• add a single item to the selection or to remove it from the selection, hold down the
Command key and click the item.

3.6 Changing the Page Layout

LPW’s way of handling the page layout differs from what you may be used from other
Macintosh word processing applications. Other applications let you specify the page
margins to be used. When the paper size changes (for example from A4 letter to US letter),
the page contents are reformatted to match the new size, sometimes destroying carefully
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crafted line and page breaks.

LPW lets you specify the area to be used for the page contents (printers call this area
the “Type Area”), and how to arrange this area on the paper. All measurements have to be
made in printers’ points. A graphical representation helps you in finding a decent page
layout.

paper rectangle

printable page area

type area

The Page Alignment options let you choose how the type area is to be arranged on the
paper: aligned with the left or right margin, aligned with the top or bottom margin, or
centered in either direction. You can then use the Page Margin fields to specify the
appropriate margins. The Type Area fields let you specify the horizontal and vertical
extension of the type area.

If you select the Use Printer Spacing option, LPW uses character widths in its
calculations that are fine-tuned for the printer you have selected with the Chooser. This
usually results in faster printing on PostScript printers, and better printing on other
printers. Screen display, however, tends to degrade, and choosing a different printer will
result in a different layout.

The Page Setup button, finally, lets you open the well-known Page Setup dialog box for
the printer you have selected with the Chooser.

3.7 Changing the Page Header

LPW lets you define a header macro. When a document is printed, the macro is filled with
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information taken from that document. This allows to achieve sophisticated effects using a
single and simple header definition.

The page headers generated by LPW always have the page number on the outer top
corner of the page. They can have an additional text in the inner top corner and a line below
the header. Headers are never shown on screen.

To get any header at all, you have to select a paragraph style to be used as the Header
Style. The header paragraph style determines the look of the header: header text is printed
using the font family, size, and style given by the header style. The location of the page
number and additional text is determined by the left and right indents set for the header
style. The overall height of the header is the sum of the line spacing and the bottom margin
of the header style.

To turn off header printing, choose “No Header” from the Header Style pop-up menu.
The other options let you design your headers. If:

• you select the Header layout for facing pages option, header and page layout are
adjusted for printing double-sided documents. Odd page numbers are printed in the top
right corner of the page, even page numbers in the top left corner, with additional text
being printed in the other top corner. You can specify different sources for the
additional text for left and right pages. In addition, the left and right page margins
resulting from the page layout specification are mirrored for even-numbered pages.

• you select the Suppress header for “New Page” pages option, headers are not printed
on pages that start with a paragraph whose paragraph style has the New Page option
selected.

• you select the Underline beneath header option, a line is printed below the header text.
The location of this line is determined by the Line Spacing set for the header style, its
width by the left and right indent.

The two clusters at the bottom let you select a source for the additional text to be printed in
the header. The cluster for the left page header text is only available if you have selected the
“Header layout for facing pages” option. If:

• you select the File Name option, the name of the document being printed is inserted
into the header.

• you select the First Paragraph of Style option and select “No Text” from the
associated pop-up menu, no additional text is inserted into the header.

• you select the First Paragraph of Style option and select a real paragraph style from the
associated pop-up menu, LPW searches for the first paragraph of that paragraph style
on the page being printed. If there is no such paragraph, it searches for the last such
paragraph on the preceding pages. The text of this paragraph (abbreviated if necessary),
is inserted into the header. Highlights within the text are ignored, and tab and return
characters are replaced with space characters.
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4. Word Processing

With regards to basic text editing operations, LPW follows the Macintosh Human Interface
Guidelines as closely as possible. You can type, select text, cut, copy, and paste just as with
any other Macintosh application. Therefore this chapter only explains LPW’s special
features.

4.1 The Module Document Window

LPW always shows you a galley view of your module documents – that is a view without
page margins and headers. Usually this view is best for editing and reading text. You can
however have the system show you where page breaks would occur when printing. If you
choose “Show Page Breaks” from the “Edit” menu, page breaks are shown with lines
like this one:

In the bottom left corner of the window, information about the current style and excerpt
selection is displayed. The current paragraph style is always shown (“First Paragraph” in
the picture). If the current highlight style is different from “Paragraph Style”, it is



appended to the paragraph style, separated by a “/”. If you have selected an excerpt other
than “Full Document”, it is shown before the paragraph style, separated with “:”. If the
paragraph style or the highlight style is not continuous over the entire selection, a question
mark is shown instead of the style name.

4.2 Selecting Text

“Selecting text” can either mean selecting a text range that the next command is to act
upon or setting the insertion point where characters you type are to be inserted. Of course
LPW allows you to make selections using the mouse and the arrow keys, but it also lets
you modify the selection process by using the modifier keys:

• Using horizontal arrow keys while holding down the Option key moves the insertion
point by words instead of by characters.

• Using horizontal arrow keys while holding down the Command key moves the
insertion point to the left or right end of the line.

• Using vertical arrow keys while holding down the Command key moves the insertion
point to the top or bottom edge of the window. If the insertion point already is at the
edge of the window, the document is scrolled up or down one windowful.

• Combining any selection method with holding down the Shift key extends the selection,
that is, the entire text between the original selection (selected without the Shift key) and
the selection that would have been made without holding the Shift key is selected.

You can use triple-clicking to select a line of text. The meaning of “line” depends on
whether you are working on program text or on documentation: For program text, the text
between two Return characters or paragraph breaks is selected, so you select what the
compiler reads as a line of source code. This source code “line” may be broken into
several lines on screen. For documentation, a line is exactly what you see as a line on
screen.

You can also use the menu commands “Select All”, “Find”, “Find Same”, and
“Find Selection” to change the selection.

4.3 Working With Styles

To apply a paragraph or highlight style to a text range, select the text and choose the style
from the menu. To apply a paragraph style to a paragraph, it suffices if the insertion point
is within that paragraph, or some characters of the paragraph are selected. To determine a
highlight style for characters you are about to type, place the insertion at the location where
you want to insert the characters, choose the highlight style from the menu, and start typing.

As was already mentioned in section 3.3 “Defining a Paragraph Style”, the current
paragraph style influences the interpretation of some of the characters you type: the
characters “"”, “´”, and “'” may be replaced by others. Typing the Return character may
start a new paragraph or start a new line only. Finally, a new line may automatically be
indented to the indentation level of the preceding line. See that section for details.
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4.4 Inserting Pictures

You can paste pictures created with other applications into LPW module documents. Each
picture will form a paragraph of its own. If the insertion is not at the beginning or the end
of a paragraph when the picture is pasted in, the paragraph will be split at the insertion
point.

The picture will be aligned between the left and right indent of the paragraph style that
you apply to it, according to the alignment selected for the paragraph style. The spacing
between the picture and the previous and the following paragraphs will be determined from
the top and bottom margin features of the paragraph styles as usual. All other paragraph
style features are ignored.

4.5 Changing Indentation

Program source text and embedded comments are usually indented to show the program
structure. To support this indentation, LPW offers repeating tabs as described in section
3.3 “Defining a Paragraph Style”, and two special commands that let you change the
indentation of large sections of source text and embedded comments: Shift Right increases
the indentation of the selected text by adding one additional tab stop at the beginning of
each line, Shift Left decreases the indentation by removing one tab stop from each line if
there is one. Both commands affect only lines for whose paragraph style a repeating tab is
defined – this means that comments, for which you have specified a repeating tab stop, are
indented along with the source code, while documentation that does not use repeating tabs
is not.

4.6 Using Excerpts

You select a current excerpt by choosing it from the “Excerpt” menu. The module
document window will only show the paragraphs that belong to the current excerpt. The
missing paragraphs will be indicated by dotted lines:

These dotted lines will not be printed.

All word processing commands only apply to the paragraphs that belong to the current
excerpt – no matter whether you change a paragraph or highlight style, or copy the
selection to the clipboard. If the selection contains paragraphs that do not belong to the
current excerpt (at least one dotted line is part of the selection), LPW will not let you use
commands that would delete the selected text. This includes typing and the “Cut”,
“Paste”, and “Clear” commands.

You can print the current excerpt using the “Print” command, and you can save it into
a separate document using the “Save As” command.
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5. Managing a Software Project

5.1 The Project Document

A project document bundles the information about all the modules belonging to a software
project that is needed to exchange information with MPW. It may also have a project style
sheet attached. The project document window shows some general information about the
project – the project style sheet and the folder to be used for exchanging information with
MPW – in the upper region, and a list of all modules belonging to the project in the lower
part.

Whenever a project document refers to another document, it internally stores the file
name and the path to the folder the document resides in. If the referenced folder is the one
the project document resides in, or a subfolder thereof, LPW uses a path relative to this
folder. This means, that you can have all files of a project in one folder, create a backup of
the entire folder, and each of the project documents will refer to its own module documents.
Using any of the mechanisms recommended by Apple – aliases or directory IDs – would
have the backup project document refer to the original module documents, so LPW does
not employ those mechanisms.

5.2 Editing the Module List

To enter a module into the module list of a project document, first open the project
document, then open the module so that one of its windows is frontmost, and finally choose
the “Add Module” command from the “Project” menu. To remove a module from the
module list, select the entry by clicking the module’s file name in the module list, then
choose the “Remove Module” command from the “Project” menu.

To select a module entry, click the module’s file name in the module list. To open the
module document or pull its window to the front, double-click the file name. You can
reorder the module list by dragging entries up or down.

As was already mentioned in the introduction, you can define an arbitrary number of



excerpts for a module document for all kinds of purposes. There are two purposes however
that are explicitly supported by the LPW project management system: printing the
documentation for the entire project, and extracting source text for MPW from the
project’s modules. For the latter purpose, LPW supports extracting up to two source files
from one module document – one for the module’s interface, one for the module’s
implementation. That’s why there are slots for three excerpt names for each module in the
module list: one for the documentation, one for the interface, one for the implementation.
The documentation excerpt is used by the “Print Documentation” command, the interface
and implementation excerpts for the “Update MPW Source Files” command.

To enter an excerpt name into a cell of the module list, select that cell by clicking it, then
choose the excerpt name from the “Excerpt” menu. The module document that the module
list entry refers to has to be open for this to work, because otherwise LPW is not able to
show you the excerpt names in the menu. There are some restrictions to the excerpts you
can enter as interface and implementation excerpts: the language selections of all paragraph
styles in this excerpt must be identical, and it must be a programming language (Make and
Rez count as programming languages for this purpose). Finally, if the language does not
support separation between interface and implementation parts, you can only enter an
implementation excerpt.

5.3 Working With a Project Style Sheet

A project style sheet allows you to use one style sheet for all the modules in a project.
LPW does not force you to use a project style sheet – if you don’t, each module will
simply use its own style sheet. But if you attach a style sheet to a project, it is automatically
used by all modules in the project.

A style sheet to be used as a project style sheet must reside in its own style sheet
document (actually that’s the only reason to have style sheet documents). A style sheet
document can be attached to several projects.

To attach a style sheet to a project, open both the style sheet document and the project
document, click into the style sheet’s window to make it the active window, then choose the
“Add Style Sheet” command from the “Project” menu. To remove the style sheet from
the project, click into the project document window to make it the active window, then
choose the “Remove Style Sheet” command from the “Project” menu.

When you attach a style sheet to a project, or when you open a project document that
has a style sheet attached, all open modules of the project are immediately adjusted to use
that style sheet. If a module uses a style that is not contained in the project style sheet, the
style is copied to the project style sheet. All other information contained in local style
sheets is discarded.

As long as the project document is open, the project style sheet is treated as if it were a
part of the project document. It is opened along with the project document – albeit without a
window. You can open the style sheet window by choosing the “Show Style Sheet”
command from the “Edit” menu when the project document window is active. Closing the
style sheet window does not close the style sheet document. When the project document is
closed, three things may happen with the style sheet document:
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• If the style sheet window is not open, and the style sheet document has not been
changed since it was last saved, it is silently closed.

• If the style sheet window is not open, but the style sheet document has been changed
since it was last saved, the window is opened, and LPW asks you whether to save the
changes. If you click Cancel, the document remains open.

• If the style sheet window is open, the document remains open.

5.4 Exchanging Information With MPW

All data that is exchanged between LPW and MPW is transmitted through files in a special
folder, known as the “MPW Exchange Folder”. You can use any folder for this purpose:
the one where your project document and your module documents reside, a subfolder of
this folder, or any other folder. To tell LPW which folder to use for a specific project, open
the project document and choose the “Define MPW Exchange Folder” command from
the “Project” menu. This enables LPW to create or update the source files for MPW.

You also want to get back error messages from MPW that relate to the modules you
have developed using LPW. LPW expects to find a file called “MPW Error Messages” in
the exchange folder, with message lines of one of the following forms:

File "file name"; Line n; Char n; error description
File "file name"; Line n; error description

LPW comes with a small MPW tool called “ParseErrors”, that extracts error messages
generated by MPW Pascal, MPW C, or Rez from a build transcript and converts them to
the form required by LPW, ignoring other messages generated by MABuild or similar
tools. If you use a different programming language, you will have to massage this tool a bit
or write your own one. To make the transmission of error messages as painless as possible,
you should call ParseErrors or your own error message extraction tool from your Build
script.

This is the procedure you would use to build your application or to find the errors
hidden in your code:

• In LPW, choose the “Update MPW Source Files” command from the “Project”
menu. LPW creates or updates the source files from the excerpts you have mentioned
in the project document list. File names are generated by using language-specific
suffixes. LPW does everything possible to prevent changing the file modification dates
unnecessarily, so as to prevent unnecessary recompilations.

• Switch over to MPW and launch your build script. If any errors are found in your
source files, the error messages should be converted for LPW as described above.

• If any errors have been found, switch back to LPW and choose the “Get MPW Error
Messages” command from the “Project” menu. LPW opens a window showing the
error messages as far as they relate to source code generated from LPW module
documents. The next section will explain how to work with this window.
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5.5 Browsing Error Messages

The error message window shows an entry for each error message generated by the MPW
compilers. Each entry will also mention the module in which the error was detected.

To get access to the erroneous source text, click the error message entry. LPW opens
the module or pulls it to the front, and selects the location where the error was found. You
can then edit the module. LPW keeps track of the changes you make to the document, so it
will always find the correct locations for all error messages, not just the first one. Error
location tracking begins when you choose the “Get MPW Error Messages” command
and ends when you close the error message window, the module document, or choose the
“Update MPW Source Files” command. Editing the module before or after this time
frame may mean that you are not shown the correct error locations.
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6. Using the Interactive Index

The Literate Programming Workshop allows you to create indexes for single module
documents or for entire projects, which can be used interactively. Using a simple menu
command, you can access the definition of a term or an identifier, and with a few mouse
clicks, you can access other locations where a term or identifier is used.

Just as with style sheets, there are local indexes for module documents and project
indexes. The difference however is that, with indexes, each module always has its own local
index, and the project index is obtained by integrating the module indexes of all project
modules and adding some additional information.

LPW distinguishes between defining and non-defining occurrences of a term or
identifier. As you will be looking for definitions most of the time, searching for them is
supported by a special “Look Up Definition” command.

6.1 Creating Index Entries

Index entries are created by one of two mechanisms: you can create entries manually, using
the “Create Index Entry” command in the “Edit” menu, or you can have LPW go
through all the modules of a project and automatically create entries for all the identifiers
defined in the module interfaces.

When you create an entry using the “Create Index Entry” command, you can select
whether it is a defining or a non-defining occurrence. Manually created entries are
maintained in the module index and are integrated into the project index.

Automatic index entries depend on information kept in the project document – the
names of the interface excerpts – and thus are only available for the project index. To have
LPW automatically create index entries, choose the “Update Index” command from the
“Project” menu. LPW uses language-specific mechanisms to extract the index entries
from the source text, so it may occasionally detect and report a syntax error.

6.2 Looking Up Index Entries

There are two ways to access the text locations you have created index entries for: either by
using the index window or by the “Look Up Definition” menu command. The “Look Up
Definition” command lets you immediately access the definition of the term or identifier
that you have currently selected in the active document. See the description of this
command in section 7.3 “The ‘Edit’ menu”.



To open the index window for the active document, choose the “Show Index” command
form the “Edit” window. The index shown will be the project index, if the active document
is either the project document or a module belonging to an open project; otherwise it will be
the module index.

The index window consists of three parts: a letter panel on top, a keyword list to the left,
and a list of occurrences to the right.

To look up a keyword, select the keyword in the keyword list. You can use the letter
panel to scroll to the first keyword starting with a specific letter. The list is ordered
alphabetically, digits and special symbols are sorted to the end.

Once you have selected a keyword, all entries for that keyword are displayed in the
occurrences list. For each occurrence, the name of the document containing the occurrence
is shown. Defining occurrences are displayed in boldface.

To access the occurrence itself, click the occurrence entry in the occurrence list. The
document will be opened and the occurrence selected.
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7. Command Reference

This chapter describes the Literate Programming Workshop menu commands, moving
along the menu bar from left to right.

7.1 The “” Menu

About LPW…
displays the same silly dialog box you get to see when you open the application. To get rid
of it, click into it.

Preferences…
lets you adjust some features of LPW to your needs.

Currently you can control two aspects using “Preferences”:

• You can tell LPW what to do when it is launched by opening the application icon.
Usually, Macintosh applications create a new document under these circumstances. As
LPW can create documents of several different kinds, it gives you the choice whether to
create a new module document, a new project document, or no new document at all.

• You can also tell LPW whether to replace typewriter-style quotation marks by
typographic quotation marks automagically. See the comments on “Language” in
section 3.3 “Defining a Paragraph Style”.

7.2 The “File” Menu

LPW has three different “New” commands, which allow you to create the three different
document types it handles. However there is only one “Open” command which lets you
open whatever type of LPW document. Whenever you create a new document, LPW



immediately asks you for a name for this document.

New Module…
creates a new module document.

New Project…
creates a new project document. You can only have one project document open at a time;
therefore, this command is available only when there is no open project document.

New Style Sheet…
creates a new style sheet document. You can attach such a document to a project document,
using the “Add Style Sheet” command in the “Project” menu.

Open…
lets you open an existing LPW document using the standard directory dialog box. You can
only open a project document when there is no project document presently opened. There
is no such limit on module or style sheet documents.

Close, Close All
“Close” closes the frontmost window. If the window was the main window of a document,
this usually also closes the document. If the document has been modified since it was last
saved, LPW asks you whether you want to save the changes.

Different rules apply to project style sheets. See section 5.3 “Working With a Project
Style Sheet”.

To close all open windows, hold down the Option key before you click in the menu bar.
This replaces the “Close” command with the “Close All” command. Choose the “Close
All” command. LPW asks you for each modified document whether to save it.

Save, Save All
“Save” saves the document the frontmost window belongs to.

To save all modified documents, hold down the Option key before you click in the
menu bar. This replaces the “Save” command with the “Save All” command. Choose the
“Save All” command.

Save As…
lets you save the document the frontmost window belongs to under a different name or in a
different location. For module documents, LPW also lets you specify a derived version to
be saved, using an extended version of the standard directory dialog box:
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• With “Text Only” selected, the document is saved as a text file without pictures and
formatting information.

• With “Current Excerpt Only” selected, only the contents of the document that belong
to the current excerpt is saved.

When you save a document using “Save As” without selecting any of the two options, the
name of the document being saved is changed to the one you enter in the dialog box. If you
have an entry for this document in an open project document, the entry is adjusted as well.

Save a Copy…
lets you save a copy of the document to which the frontmost window belongs. The
additional checkboxes of the “Save As” dialog do not appear and the document name is
not changed. This command is used primarily for creating backups from inside LPW.

Revert
restores the version of the document last saved. This command cannot be applied to a
project style sheet.

Allow Modifications
is for Projector users only: it lets you gain permission to modify a document that was
checked out from Projector as read only. For more information, see section 2.3
“Determining Whether a Document Can Be Modified”.

Page Layout…
lets you modify a page layout. If the frontmost window belongs to a style sheet document,
the command applies to that document; if the frontmost window belongs to a module
document, it applies to the style sheet used for that document which may either be its local
style sheet or the project style sheet. Please refer to section 3.6 “Changing the Page
Layout” for further information.

Page Header…
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lets you modify a page header. If the frontmost window belongs to a style sheet document,
the command applies to that document. If the frontmost window belongs to a module
document, it applies to the style sheet used for that document, which may either be its local
style sheet or the project style sheet. Please refer to section 3.7 “Changing the Page
Header” for further information.

Print…
lets you print the active document. There are some gimmicks for printing module
documents:

• If you have previously done a “Page Setup” for a different printer than the one
currently selected with the chooser, LPW does not mess around with the document’s
page layout to match the current printer. Instead, it tells you about the problem, and lets
you decide what to do. If you want to print to the current printer, open the “Page
Layout” dialog box, click the Page Setup button in that dialog box, and do what needs
to be done.

• The print job dialog is extended by a few buttons:

– the Direction buttons let you choose whether you want to print the document front
to back or reverse.

– the Pages buttons let you choose whether to print all pages, odd, or even pages
only.

You can use these features to print on both sides, but what exactly to select depends on
the printer you use. On a LaserWriter Plus, for example, you would print even pages
forward first, then odd pages reverse.

• LPW always prints the current excerpt.

Quit
lets you quit the application. LPW first asks whether you want to save the documents you
have modified. During this process you can cancel the “Quit” command.
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7.3 The “Edit” Menu

The commands in the “Edit” menu are primarily intended to allow editing module
documents. Some commands, however, also apply to other types of documents, or are
document independent. The command “Undo/Redo” applies to all kinds of documents.
The “Show/Hide Clipboard” is independent from any document. The “Clear”, “Show
Index”, and “Show Style Sheet” commands also apply to project documents.

Undo, Redo
This command comes in many variations, but you know what it does.

There is one problem you should be aware of: LPW only offers you to undo a
command when the document that the command applies to is active, i.e., when one of its
windows is frontmost. Usually, this feature avoids confusion, but sometimes it leads to
strange effects. If the frontmost window belongs to a module document that uses a project
style sheet for formatting, you can change definitions in the project style sheet right away,
but you have to open the style sheet to be allowed to undo the changes.

Cut
removes the selected text or pictures from a document and places it in the Clipboard.

Copy
places a copy of the selected text or pictures in the Clipboard.

Paste
copies the contents of the Clipboard into the active document at the insertion point. If text is
currently selected, it is replaced. LPW can not only paste data copied from LPW
documents, but also the standard Macintosh data formats for text and pictures.

Clear
removes the currently selected text or pictures from a module document, the currently
selected paragraph style, highlight style, or excerpt definition from a style sheet, or the
current excerpt entry from a project document.

Find…
lets you search for some text in the active module document.
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Enter the text you want to find into the text field. Some options allow you to control the
search method:

• Entire Words finds locations only where the search string occurs as a single word. The
definition of a word depends on the language.

• Case Sensitive makes the search case sensitive; if you don’t select this checkbox,
searching is case insensitive.

• Wrap-Around Search searches to the end of the document, then wraps around to the
beginning of the document. Searching ends at the location where the search was
initiated.

• Current Excerpt Only searches for the specified string in the current excerpt only.

The search is initiated by clicking the “Find” button. A beep indicates that the string was
not found.

The dialog box is closed immediately, but the search string and the options you selected
are remembered for later use.

Find Same
finds the next occurrence of the search string you specified when you last chose the
“Find” or “Find Selection” command, by using the options from the last invocation of
the “Find” command. If you have not specified a search string before, you are presented
with the “Find” dialog box.

Find Selection
finds the next occurrence of the currently selected text using the options you specified
when you last used the “Find” command.

Select All
selects the entire contents of the current excerpt.

Shift Left
shifts all selected text within paragraphs for whose paragraph style a repeating tab is
defined to the left by removing one tab character at the beginning of each line. Not affected
are: pictures, text not shown in the current excerpt, text whose paragraph style does not
have a repeating tab, and lines that do not start with a tab character at the beginning.
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Shift Right
shifts all selected text within paragraphs for whose paragraph style a repeating tab is
defined to the right by adding one tab character at the beginning of each line. Not affected
are: pictures, text not shown in the current excerpt, and text whose paragraph style does not
have a repeating tab.

Create Index Entry…
lets you specify an index entry for the current selection.

• The text you enter is used for the entry in the index. Initially, this is the text that was
selected in the document, but you can change it to a synonymous expression or
whatever you like.

• Selecting Definition marks the entry as referring to a definition, making it eligible for
direct access using the “Look Up Definition” command.

Look Up Definition
lets you look up the definition of the currently selected word using an index for the active
document. If a project document is open and the active document is part of the project, the
project index is used for finding the definition, otherwise the module document’s local
index is used. If the index contains exactly one entry marked as referring to a definition, the
document containing the definition is opened and the definition is selected; if the index
contains references to more than one definition, the index window is opened and the
keyword selected.

Show Index
opens the index window or pulls it to the front. If a project document is open and the active
document is part of the project, the window shows the project index. Otherwise it shows the
active document’s local index.

Show Page Breaks
lets you switch screen feedback for page breaks on or off. When switched on, each page
break in a document is indicated by a line like the following one:

Show Style Sheet
opens a window showing the style sheet for the active document or pulls that window to the
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front.

Show Clipboard
Hide Clipboard
“Show Clipboard” opens a window showing the contents of the Clipboard or pulls that
window to the front. “Hide Clipboard” closes the window.

7.4 The “Paragraph” Menu

Define Paragraph Style…
lets you define a new paragraph style or modify an existing definition. See Section 3.3
“Defining a Paragraph Style”.

This menu also contains entries for all paragraph styles defined for the active
document. To apply a paragraph style to a paragraph, first select the paragraph, select some
text in the paragraph, or simply place the insertion point in the paragraph, then choose the
new paragraph style from the menu.

To change the order in which the paragraph styles appear in the menu, open the style
sheet window and drag list entries up or down.

A new module or style sheet document contains a default paragraph style, that you can
modify if you wish.

7.5 The “Highlight” Menu

Define Highlight Style…
lets you define a new highlight style or modify an existing definition. See section 3.4
“Defining a Highlight Style”.

This menu also contains entries for all highlight styles defined for the active document.
To apply a highlight style to a range of text, first select the text, then choose the new
highlight style from the menu. To determine the highlight style to be used for newly typed
text, position the insertion point at the location where you want to insert text, choose the
highlight style from the menu, and start typing.

To change the order in which the highlight styles appear in the menu, open the style
sheet window and drag list entries up or down.

A new module or style sheet document contains a default highlight style called
“Paragraph Style” which does in no way modify the underlying paragraph style. This
highlight style cannot be modified.

7.6 The “Excerpt” Menu

Define Excerpt…
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lets you define a new excerpt or modify an existing definition. See section 3.5 “Defining
an Excerpt”.

This menu also contains entries for all excerpts defined for the active document. To
have an excerpt of a document be shown, choose the excerpt name from the menu. If the
excerpt does not contain all paragraphs of a document, the locations where paragraphs have
been omitted are indicated on screen by lines like the following one:

These lines will never show up on printed output.

To change the order in which the excerpts appear in the menu, open the style sheet
window and drag list entries up or down.

A new module or style sheet document contains a default excerpt definition called
“Full Document” which displays the full document. This excerpt cannot be modified.

7.7 The “Project” Menu

Add Module
adds an entry for the active document – a module document – to the project document that
is currently open. If a style sheet is attached to the project, the active document is adjusted
to use this style sheet.

Add Style Sheet
attaches the active document – a style sheet document – to the project document that is
currently open. All open module documents that belong to the project are adjusted to use
this style sheet. This command is available only when the project has no style sheet
attached yet.

Remove Module
removes the selected module entry from the project document. If a style sheet is attached to
the project, this also disconnects the module document from the style sheet. The module
document receives a copy of the project style sheet as its initial local style sheet.

Remove Style Sheet
removes the style sheet from the project. This also breaks all connections between the
project’s module documents and the style sheet. Each module document receives a copy of
the project style sheet as its initial local style sheet.

Print Documentation…
lets you print the documentation for a project. The documentation consists of the
documentation excerpts of all modules for which such an excerpt has been specified in the
project document.
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Update Index
collects up-to-date information for the project index from the project’s modules. This
means getting information about index entries which have been created manually while the
project document was not open. It also means regenerating the information obtained
automatically by parsing the interface excerpts of the project’s modules.

Define MPW Exchange Folder…
lets you specify the folder to be used for exchanging information with MPW:

In addition to the well-known elements of the dialog box used for opening a document,
there are two new buttons:

• Select Current Folder selects the folder whose contents are currently shown. In the
screen shot above, that’s “Temporary”.

• Folder selects the folder which is selected in the list. In the screen shot above, that’s
“Sources”.

Update MPW Source Files
prepares up-to-date source text files for MPW in the MPW Exchange Folder. See section
5.4 “Exchanging Information With MPW”.

Get MPW Error Messages
reads the error messages produced by MPW and displays them in an error message
window as far as they relate to modules belonging to the current project. See section 5.4
“Exchanging Information With MPW”.
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8. Known Bugs and Limitations

The Literate Programming Workshop currently supports the Roman script only. As the
Macintosh system treats some fonts with Greek letters and symbols as Roman, you can use
those fonts as well; this may, however, lead to strange effects – e.g. an “α” shows up in
the index as “a”.

Automatic index entry generation is currently supported for Object Pascal and C++
only. The Object Pascal parser has shown to be very reliable, but the C++ parser may
sometimes get confused by odd features of C++. Most important, it does not do
preprocessing – it tries to skip over preprocessor lines, but may get confused by some
combinations of preprocessor lines and comments.

If two paragraphs are less than two pixels apart, the lines indicating omitted paragraphs
and line breaks disappear when editing the first line of the second paragraph. The line
indicating a page break within a paragraph may disappear when editing the line following
the page break. If you wish to make sure all those lines appear, page up and back down.

LPW has not been tested under A/UX, and it is known that the mechanism used by the
project management system to locate files is not compatible with A/UX.

If you change the Macintosh’s string sorting mechanism by installing a different
system or by selecting a different sorting order from the “International” or “Text”
control panels, the order of the keys in the index will suffer.

You can undo or redo a command only when the document it refers to is active.

You can not delete index entries.



9. Change History

9.1 Changes from LPW 1.0 to LPW 1.1

The following features were added:

• repeating tabs,

• the Shift Left and Shift Right commands,

• triple clicking,

• the Save All and Close All commands.

Also, a few bugs were fixed.

LPW 1.0 and 1.1 share the same file formats, but as LPW 1.0 does not know about
repeating tabs, it displays LPW 1.1 documents using this new feature in a less-than-perfect
manner.

9.2 Changes from LPW 1.1 to LPW 1.2

The following features were added:

• wide views (rulers without right margin),

• deleting style and excerpt definitions.

The Save All and Close All commands are now alternatives to the Save and Close
commands, reached by using the Option key. Also, a few bugs were fixed.

LPW 1.2 still uses the LPW 1.0 file format, but as LPW 1.0 and 1.1 don’t know about
wide views, they display LPW 1.2 documents using this new feature in a less-than-perfect
manner.


